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Introduction 
This manual is intended to accompany the Home Range Tools (HRT) for the ArcGIS® 9.x 

Geographic Information System (GIS). The manual has been written for novice GIS users who already 

understand basic wildlife telemetry issues and who are familiar with the concept of a “home range”. 

The HRT contains software that extends ArcGIS to analyze home ranges of animals. This is 

accomplished within a GIS, which provides a common and relatively familiar interface for analyses 

performed on telemetry fixes and home range polygons. The user should be able to perform all the analyses 

of their point data within ArcGIS and the HRT. 

What is “Home Range Analysis” 

Field studies of animals commonly record the locations where individuals are observed. In many 

cases these point data, often referred to as “fixes”, are determined by radio telemetry. These data may be 

used in both “basic” and “applied” contexts. The information may be used to test basic hypotheses 

concerning animal behaviour, resource use, population distribution, or interactions among individuals and 

populations. Location data may also be used in conservation and management of species. The problem for 

researchers is to determine which data points are relevant to their needs and how to best summarize the 

information. 

Researchers are rarely interested in every point that is visited, or the entire area used by an animal 

during its lifetime. Instead, they focus on the animal’s “home range”, which is defined as “…that area 

traversed by the individual in its normal activities of food gathering, mating, and caring for young. 

Occasional sallies outside the area, perhaps exploratory in nature, should not be considered as in part of the 

home range.” (Burt 1943). Thus, in its simplest form, “home range analysis” involves the delineation of the 

area in which an animal conducts its “normal” activities. This can often be accomplished through 

subjective evaluation. To maintain scientific integrity (i.e., repeatability) or for comparisons with other 

studies, however, objective criteria must be used to select movements that are “normal” (White and Garrott 

1990). The obvious difficulty is in the definition of what should be considered “normal”. Because of this 

difficulty, there has been a proliferation of home range analysis models. 

Depending on the general treatment of point location estimates, home range analysis models can 

be classified into four fundamentally different approaches; minimum convex polygons, bivariate normal 

models (Jennrich-Turner estimator, weighted bivariate normal estimator, multiple ellipses, Dunn 

estimator), nonparametric models (grid cell counts, Fourier series smoothing, harmonic mean), and 

contouring models (peeled polygons, kernel methods, hierarchical incremental cluster analysis). All of 

these methods can be used to estimate areas occupied by animals, but some have been developed to 

specifically elucidate characteristics of home range shape (e.g., bivariate normal models) or structure (e.g., 

contouring models). If home range size is combined with information about home range shape, then it is 

possible to estimate resources available to individuals in a population. Consideration of home range shape 
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may also allow identification of potential interactions among individuals. Analytical models developed to 

examine home range structure may be useful in the identification of areas within home ranges that are used 

by individuals for specific purposes such as nest sites or food caches. However, home range analysis may 

involve more than just estimating the characteristics of areas occupied by animals. Researchers often want 

to know about the distances, headings, times and speed of animal movements between locations. They may 

also want to assess interactions of animals based on areas of overlap among home ranges or distances 

between individuals at a particular point in time. Thus, home range analysis comprises a wide variety of 

techniques and approaches. Most of these methods and their limitations have been reviewed by Harris et al. 

(1990), White and Garrott (1990) and Powell (2000). 

Why use ArcGIS? 

Just as there has been a proliferation of home range analysis models, there has been a proliferation 

of home range analysis software. Characteristics of many software programs used to estimate animal home 

ranges are summarized by Larkin and Halkin (1994) and Lawson and Rodgers (1997). Most of these are 

older DOS-based programs with a cumbersome interface that requires batch files or data manipulation to be 

carried out with text editors or database programs. This results in a multi-stage procedure that is time-

consuming and has the potential for error at each step in the process. Because of their age, most of the 

existing programs do not include some of the more recent home range models (e.g., kernel methods). Many 

of these programs do not allow export of home range polygons to a GIS for habitat analyses. Of those that 

do, some are limited to fewer than 1,000 animal locations in the home range analysis. Although these 

limitations may be acceptable to studies involving conventional radio-tracking of animals, automated 

equipment such as GPS-based telemetry systems (Rodgers et al. 1996, Rodgers 2001) can easily generate 

enormous quantities of data that cannot be entirely analyzed by these previous software programs. The 

ability to use large data sets and carry out all required home range analyses within a single software 

environment was a primary reason for developing the HRT within ArcGIS. 

Techniques Available in the HRT 

The HRT includes 2 home range analysis models: minimum convex polygons (MCPs) and kernel 

methods. Although they have been severely criticized, MCPs have been included because they are easy to 

compare among studies and they are the most frequently used (Harris et al. 1990, White and Garrott 1990). 

Whereas MCPs do not indicate how intensively different parts of an animal’s range are used, kernel 

methods allow determination of centres of activity (Worton 1989, 1995, Seaman and Powell 1996). 

Because different computer software programs may produce large differences in home range estimates 

based on these models (Lawson and Rodgers 1997), we have attempted to provide all of the options offered 

in earlier programs for calculation of the estimators and values input for various parameters. 
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Minimum Convex Polygons 

Minimum convex polygons (MCPs) are constructed by connecting the peripheral points of a group 

of points, such that external angles are greater than 180° (Mohr 1947). “Percent” minimum convex 

polygons (%MCPs) (Michener 1979), sometimes referred to as “probability polygons” (Kenward 1987), 

“restricted polygons” (Harris et al. 1990), or “mononuclear peeled polygons” (Kenward and Hodder1996), 

can be generated for a subset of fixes using one of several percentage selection methods available in the 

HRT. These methods include both the exclusion of points from a calculated (e.g., mean) or user-specified 

(e.g., nest site) location, and an ordering criterion based on the amount of area each point contributes to the 

%MCP (White and Garrott 1990). 

Kernel Methods 

Kernel analysis is a nonparametric statistical method for estimating probability densities from a set 

of points. Kernel probability density estimation is well understood by statisticians, having been well 

explored since the 1950s. However, kernel methods have only been used in home range analysis since the 

1990s (Worton 1989). In the context of home range analysis, these methods describe the probability of 

finding an animal in any one place. The method begins by centering a bivariate probability density function 

with unit volume (i.e., the “kernel”) over each recorded point. A regular grid is then superimposed on the 

data and a probability density estimate is calculated at each grid intersection by summing the overlapping 

volumes of the kernels. A bivariate kernel probability density estimator (i.e., a “utilization distribution”) is 

then calculated over the entire grid using the probability density estimates at each grid intersection. The 

resulting kernel probability density estimator will have relatively large values in areas with many 

observations and low values in areas with few. Home range estimates are derived by drawing contour lines 

(i.e., isopleths) based on the summed volumes of the kernels at grid intersections. These isopleths define 

home range polygons at different probability levels whose areas can be calculated. 

The HRT includes both fixed and adaptive kernel methods. The kernel probability density 

function used in the HRT is the standard bivariate normal (i.e., Gaussian) curve. Other kernel functions are 

described in Silverman (1986), but have not been implemented. The choice of an appropriate “smoothing 

factor” (i.e., “bandwidth”) is much more important than the choice of a kernel (Worton 1989) and there 

should be little difference between the estimates of home range produced by different kernel functions 

compared to the differences caused by the choice of smoothing factor (Wand and Jones 1995). Several 

automated and subjective methods of finding the “best” smoothing factor are provided in the HRT. 

Kernel methods in the home range literature are derived from Worton (1989). His paper was 

primarily based on Silverman (1986). Both of these works are essential reading but much has been written 

since and, although not an exhaustive list, we also recommend the following as an introduction to kernel 

methods and their application; Wand and Jones (1995), Worton (1995), Seaman and Powell (1996), 

Bowman and Azzalini (1997), Seaman et al. (1999), Powell (2000), Blundell et al. (2001), Kernohan et al. 

(2001) and Millspaugh et al. (2006). There have also been numerous studies of smoothing parameter choice 
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for kernel density estimation and the following readings are also recommended; Wand and Jones (1995), 

Jones et al. (1996), Gitzen and Millspaugh (2003), Hemson et al. (2005), Gitzen et al. (2006), Horne and 

Garton (2006), Fieberg (2007a,b), Downs and Horner (2008), and Kie et al. (2010). 

Installing and Removing the Home Range Tools 
The HRT requires ArcGIS 9.x, running under Windows XP (as far as we know it will also run 

under Windows Vista and Windows 7 but we have not tested it ourselves). To install the HRT, navigate to 

the folder on your hard drive where you stored the downloaded HRT9.zip file and extract the contents. Run 

(double click) the setup.exe program and the HRT will be installed by default to a c:\Program Files\HRT\ 

folder: if you prefer, the location of the HRT can be changed during the install process. To activate the 

HRT following installation, start ArcMap™, click on the Tools menu and choose “Customize”. On the 

Toolbars tab in the dialog box that appears, place a check mark in the box beside Home Range Tools 

Arcgis 9. Alternatively, click on the View menu, choose Toolbars and select Home Range Tools Arcgis 9. 

You can also right click on any toolbar in the ArcMap window and select Home Range Tools Arcgis 9. 

Any of these methods will add the HRT Tools dropdown menu to the Data View window, after which it 

can be dragged to a toolbar. To uninstall the HRT, use the Add or Remove Programs utility in the Control 

Panel. 

Importing Fix Data 
Fix data come in a wide variety of formats. You may already have it in an ESRI™ shapefile, you 

may have it in a spreadsheet or database file, or a simple text file. Since the HRT was developed at a site 

using Lotek GPS collars, we have included an import filter for data files produced by their GPS Host and 

N4Win software (MDB files). 

Regardless of the original format, files must be converted to shapefiles (point layers) and certain 

types of information must be included for full functionality of the HRT. Most importantly, the location data 

must be in UTM units (meters). The input data file must include a 

unique animal ID field (column) to perform “Kernel Density 

Estimation”. It is critically important that the animal ID field is 

defined as a text field. To “Calculate Travel Times and Distances” 

between successive fixes, the input data file must also include a field 

called “Time2” (see further description below). Before importing data, set the “Data Frame Properties…” 

on the View menu to one of the Predefined Projected UTM Coordinate Systems. 

Distances and areas in the 
HRT are measured in meters 
and square meters, 
respectively, so location 
data must be in UTM units 
(meters). 
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ESRI Shapefiles 

ESRI shp files can be added as a layer to the Data View window in the normal ArcGIS way using 

the Add Data ( ) button or by selecting “Add Data…” from the File menu. 

Text Files and dBASE Files 

Text files (comma-separated values, tab-delimited ASCII) and dBASE files are treated identically. 

To use all of the HRT features the file must include a text field that uniquely identifies the animal(s), a 

Converting Geographic to UTM coordinates in ArcGIS 
 
Location data are often recorded in a geographic coordinate system (e.g., decimal degrees) but distances and areas in the HRT are 
measured and calculated in meters and square meters, respectively, so location data must be converted to UTM units (meters) 
before they can be used in the HRT. The following steps outline the process of converting Geographic to UTM coordinates in 
ArcGIS; 
 
1. Open ArcCatalog and navigate to the file that contains the locations to be converted. 
 
2. Right click on the file name in the Contents window and select “Create Feature Class” then “From XY Table…”. 
 
3. In the X Field of the dialog box, select the column containing the longitude data and in the Y Field of the dialog box, select 

the column containing the latitude data. 
 
4. Next, click “Coordinate System of Input Coordinates…” to specify the format of the original location data. 
 
5. In the Spatial Reference Properties dialog box that now appears, click on the Select button. 
 
6. In the Browse for Coordinate System dialog box, select the geographic coordinate system used for the original location data 

using the predefined Geographic Coordinate Systems (e.g., click the Geographic Coordinate Systems folder, then the North 
America folder, and select North American Datum 1983.prj) then click the Add button. 

 
7. This brings you back to the Spatial Reference Properties dialog box where you should click the Apply button then the OK 

button. 
 
8. Now “Specify output shapefile or feature class…” by providing a path and name for the Output shapefile then click 

“Advanced Geometry Options…” to specify the format of the location data in UTM units. 
 
9. Check that the button next to “Use a different spatial reference” is selected then click “Edit…”. 
 
10. In the Spatial Reference Properties dialog box, click on the Select button. 
 
11. In the Browse for Coordinate System dialog box, choose one of the predefined Projected Coordinate Systems to convert 

your data to a UTM coordinate system (e.g., click the Projected Coordinate Systems folder, then Utm, Nad 1983 and select 
NAD 1983 UTM Zone 15N.prj) then click the Add button. 

 
12. This will again bring you back to the Spatial Reference Properties dialog box where you should click the Apply button then 

the OK button. 
 
13. Click OK in the Advanced Geometry Options dialog box as well as the Create Feature Class from XY Table dialog box. 
 
14. To verify that the new shapefile has been created, select “Refresh” from the View dropdown menu in ArcCatalog. 
 
15. Now, open ArcMap and Add the new shapefile you just created in ArcCatalog. 
 
Note: if you want to save the UTM coordinates in the shapefile after you open ArcMap, open ArcToolbox, select Data 
Management Tools, then Features, then Add XY Coordinates. Navigate to the shapefile and select it as the “Input Features”. 
Click the Environments… button at the bottom of the dialogue box, then click on General Settings. On the Output Coordinate 
System drop-down menu, select Same as Display. Click OK, which will return you to the Add XY Coordinates dialogue, then 
click OK again. This will add two new fields to the Attribute Table, POINT_X and POINT_Y, corresponding to the UTM 
coordinates of longitude and latitude. 
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numeric “Time2” field and separate numeric fields for latitude and longitude in UTM units. Before 

attempting to use one of these file types you should check and, if necessary, edit the field names in the file 

using a spreadsheet (e.g., Excel) or text editing (e.g., WordPad) program because some characters are not 

supported by ArcMap, such as dashes (e.g., x-coord), spaces and brackets (note that you can use the 

underscore character instead of the dash character in field names). You should also delete any records from 

the file that do not have co-ordinate data; e.g., some GPS units may record an unsuccessful attempt to 

acquire a fix as “N.A.” and these records should be removed from the file. 

The HRT uses a “Time2” field to “Calculate Travel Times and Distances” between successive 

fixes. Thus, locations in your file must be associated with a linear “time” scale that provides a unique value 

for each point, otherwise this HRT option will not work. Any linear scale can be used, although the 

preferred format is the number of seconds elapsed since a specific point in time; e.g., the GPS time standard 

of seconds since midnight 1/1/1970 or the number of seconds elapsed since the beginning of your study. 

You could simply order your data and number the sequence from first to last in the “Time2” column, but 

calculated times and speeds of movement may be nonsensical unless locations were obtained at equal time 

intervals. 

 

Creating a Time2 Field 
 
The HRT requires a field labeled Time2, representing continuous time in seconds, for most time and distance calculations, as well 
as display travel options.  This field can be created in Microsoft Excel.  Obviously, specifics depend on how your date and time 
data are formatted.  Below is an example that can be modified as needed. 
 
Assuming your date and time look like the following example (where date is day/month/year and time is displayed as 
hours:minutes:seconds): 
 
 10/5/2010  13:30:00 
 10/5/2010  13:30:10 
 01/1/1900  13:30:00 
 
Now reformat the date column to number, with 0 decimal places. 
 
 40456  13:30:00 
 40456  13:30:10 
          1  13:30:00 
 
You now have a column with a running number of days since the start of the 20th century. 
 
Now reformat the time column to number (shown here with 6 decimal places).  The result is a proportion of a 24-hour day. 
 
     40456  0.562500 
     40456  0.562616 
         1  0.562500 
 
There are 86,400 seconds in a day, so simply add the new date and time columns together, then multiply by 86,400 to get a new 
Time2 field. 
 
     40456 + 0.562500 = 40456.562500 x 86,400 = 3495447000 
     40456  + 0.562616 = 40456.562616 x 86,400 = 3495447010 
 1  + 0.562500 = 1.5625 x 86,400 = 135000 
 
You can see that the difference in times between the first 2 dates and times is 10 seconds, which is what we expected.  Time2 
calculated this way is a very big number, so in ArcMap you should specify the field format as ‘double’ rather than ‘long integer’. 
In fact, it would be advisable in the above example to subtract 3400000000 from each of the larger two values to reduce the 
number of digits and avoid potential problems – as you can see this would have no effect on the time differences. 
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To add text (csv, txt) or dBASE (dbf) files as a layer to the Data View, use the Add Data ( ) 

button or select “Add Data…” from the File menu. Navigate to the file then click the Add button. This 

brings your file into ArcMap but does not yet display the data (i.e., the file name is available in the Source 

Table of Contents window on the left and you can open it by right clicking, but nothing appears yet in the 

Display Table of Contents window). Right click on the file name in the Source Table of Contents and select 

“Display XY Data…”. In the X Field of the dialog box, select the column containing the longitude data in 

UTM units. Similarly, in the Y Field of the dialog box, select the column containing the latitude data in 

UTM units. Click on the Edit button. In the Spatial Reference Properties dialog box that now appears, click 

on the Select button (or one of the others if you know how to use them). In the Browse for Coordinate 

System dialog box, select the same UTM system as for the Data Frame Properties using the predefined 

Projected Coordinate Systems (e.g., click the Projected Coordinate Systems folder, then Utm, Nad 1983 

and select NAD 1983 UTM Zone 15N.prj) then click the Add button. This brings you back to the Spatial 

Reference Properties dialog box where you should click the Apply button then the OK button. You should 

now be back at the Display XY Data dialog box. Click the OK button. Your data points should now be 

displayed in the Data View and the file name should now appear in both the Source and Display Table of 

Contents windows labeled as “Events”. However, the layer needs to be converted to a shapefile before you 

can use all of the HRT options. 

To create a shapefile, right click on the “Events” file in either the Source or Display Table of 

Contents window and select “Data” then “Export Data”. In the Export Data dialog box, select “Use the 

same Coordinate System as: the data frame”, specify the path and file name for the “Output shapefile or 

feature class:”, then click OK. Click Yes to add the exported data to the map as a layer. You now have a 

shapefile to use with the HRT. 

Lotek MDB Files 

Lotek MDB files are produced by their GPS Host and N4Win software using data downloaded 

from their early model GPS collars (GPS 1000 and 2000) and differential correction data from a GPS base 

station. These files can be imported directly to the HRT, or the Lotek software can be used to output the 

data in a text file format (csv or txt) that can be edited and imported as outlined above. The MDB files do 

not contain location data in UTM units but rather milliseconds of latitude and longitude. During the import 

process these are projected into the Predefined Projected Utm Coordinate System set in the “Data Frame 

Properties…” on the View menu before importing the data. Subsequently, imported Lotek MDB files have 

all of the information required for full functionality of the HRT. 
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To import a Lotek MDB file, select “Import 

Lotek MDB Files” from the HRT Tools dropdown 

menu. An Open file dialog box will pop up (Figure 1). 

Navigate to the folder containing the Lotek MDB 

file(s), highlight the file you want, and click Open. In 

the Save As dialog box that appears (Figure 2), type the 

name of the new shapefile that will be created by the 

import process. The file will be imported and the 

location data will be converted from milliseconds and 

projected into the Predefined Projected Utm Coordinate 

System previously set in the “Data Frame Properties…” 

on the View menu. If the file includes records of unsuccessful 

attempts to acquire a GPS location, you will be informed that 

“Your dataset may have records whose fix status is ″acquiring″”. 

The script will ask you whether or not you want to Include or 

Exclude these records. You may also choose to Cancel the import 

process. With the exception of removing duplicate time or 

location records, all of the other HRT options require valid 

location data to function correctly, so you should Exclude these 

unsuccessful attempts to acquire a GPS fix. When the import 

process has finished, the name of the shapefile will be displayed 

in the Display and Source Table of Contents windows and the 

locations will appear in the Data View, ready for use by the HRT. 

 

The list of attributes associated with the data, revealed 

by right-clicking on the shapefile and selecting “Open Attribute Table”, is shown in Table 1. 

 

 
 

Figure 1.  The Open file dialog 
box, showing a selected 
Lotek MDB file. 

 
 

Figure 2.  The Save As dialog 
box, showing the name of the 
new shapefile that will be 
created by the “Import Lotek 
MDB Files” process. 
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Table 1.  Attributes of data in a shapefile imported by the HRT to ArcGIS from a Lotek 

MDB file. 

 

Attribute Description 

FID A unique ArcGIS  identification number for each record 

Shape The type of ArcGIS feature represented by each record (i.e. 

points) 

CollarID GPS collar hexadecimal address for data downloading – can 

be used by the HRT as a unique animal ID field 

Time1 Time of day in AM/PM format 

Date Date in day/month/year format 

Time2 Seconds since midnight 1/1/1970 

FixStatus Type of GPS fix (2-dimensional or 3-dimensional differentially 

corrected) 

DOP GPS Dilution of Precision 

ReceiverSt GPS receiver status 

Convergenc GPS satellite convergence 

Activity Average activity in predefined time period from sensor in GPS 

collar 

TTFF Time to acquire signals from at least 3 GPS satellites 

Temperatur Ambient temperature in °C from sensor in GPS collar 

 

 

 

ARC/INFO Coverages 

ARC/INFO coverages can be added to the Data View in the normal ArcGIS way using the Add 

Data ( ) button or by selecting “Add Data…” from the File menu. Find the coverage and highlight it in 

the Add Data dialog box, then click the Add button. 

Other Information 

All sorts of other information can be imported into ArcGIS, in a variety of ways. The “ArcGIS 

Desktop Help” file and link to “ArcGIS Desktop Help Online” available on the Help menu are useful 

resources and a good place to start if you are not already familiar with ArcGIS. 
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Editing Fix Data 
Sometimes there are irrelevant fixes that need to be removed from data files before further 

analyses can proceed. For instance, locations recorded during the process of initializing GPS collars, prior 

to deployment on animals. Another problem is the occurrence of duplicate points in a data file. This might 

occur due to transcription errors or when files are merged (see below). These records can be identified and 

removed from text or dBase files using a spreadsheet (e.g., Excel) or 

text editing (e.g., WordPad) program before importing to ArcGIS. 

Otherwise, you may choose to edit the shapefiles created in ArcGIS 

after data are imported, as described below. In addition to the editing 

features provided by ArcGIS, the HRT includes a couple of options for 

removing duplicate data. 

Removing Individual Points 

There are many ways to select individual points for editing in ArcGIS using options on the 

Selection menu and the Editor Toolbar. However, a simple interactive method is to make use of the Select 

Feature tool ( ) on the Tools Toolbar. Activate the Editor Toolbar ( ) and select “Start Editing” on the 

Editor dropdown menu ( ). Highlight the shapefile to be edited in either the Source or Display Table 

of Contents window. Select the point to be removed using the Select Feature tool. Multiple points can be 

removed by dragging a box around a group of points or by holding the Shift key while selecting individual 

points with the Select Feature tool. You could also use the “Select By Attributes…” or “Select By 

Location…” options on the Selection menu to remove single or multiple points. Press the Delete key on the 

keyboard to remove the selected points. When you are finished removing points, select “Stop Editing” from 

the Editor dropdown menu. You will be asked if you want to save your edits. It is important to realize that 

if you choose to save your edits, the original shapefile will be overwritten. 

Removing Duplicates 

Rather than manually editing an Attribute Table, there is an easy way to remove time or location 

duplicates from a shapefile using the HRT. Highlight the shapefile that you want to check for duplicates in 

either the Display or Source Table of Contents window. Select the points you want to check for duplicates 

using the Select Feature tool ( ) on the Tools Toolbar or one of the options on the Selection menu, as 

outlined above. You can select all the points in a shapefile by right clicking on the file name then choosing 

“Select All” from the Selection fly-out menu. After selecting the points, choose “Remove X/Y Duplicates” 

or “Remove Time2 Field Duplicates” from the HRT Tools dropdown menu ( ). If there are any 

duplicates in the file, a dialog box will pop up and indicate how many duplicates were deleted from the file. 

Note that these locations are permanently removed from the shapefile. 

Before you start editing, 
you should make a backup 
copy of your shapefile(s). 
Removing individual points, 
including duplicates, will 
overwrite the original 
shapefile. 
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Merging Shapefiles 

To merge shapefiles, such as multiple downloads from the same animal’s GPS collar or location 

files collected at intervals, use the Merge Tool found by clicking on the ArcToolbox icon ( ) then 

selecting Data Management Tools, General and Merge. The Merge dialog box allows selection of two or 

more files to be merged and will create a new shapefile containing all the features from the input files. The 

attribute types of the shapefiles to be merged should be identical to ensure subsequent functionality of the 

HRT. You should check the new shapefile for X/Y duplicates or Time2 Field duplicates as outlined above. 

Exploratory 
There are two major exploratory data analysis tools available in the HRT; basic ArcGIS queries, 

and “Display Travel”. The queries use the Identify tool ( ) and the “Select By Attributes…” or “Select 

By Location…” options on the Selection menu, as previously described. “Display Travel”, on the other 

hand, is an interactive data walkabout tool. 

Display Travel 

The “Display Travel” option lets you follow an animal’s path in the Data View window as it 

moves from point to point. To explore the movements in a data set, click the shapefile (point layer) that you 

would like to use in the Source or Display Table of Contents and make it visible by checking the box next 

to it. Only one shapefile at a time can be processed. You can select all the points in the active shapefile by 

right clicking on the file name then choosing “Select All” from the Selection fly-out menu. If you don’t 

want to use the entire shapefile, you can use the Select Feature tool ( ) on the Tools Toolbar to drag a 

box around a subset of the points in the Data View window or use one of the options on the Selection menu 

to select a subset of points, as outlined above. To start the process, select “Display Travel” from the HRT 

Tools dropdown menu ( ). A dialog box (Figure 3) will pop up that allows you to control the 

display and provides information about the fixes. 

When the “Display 

Travel” dialog (Figure 3) first 

appears, the date and time of the 

first selected fix is shown next 

to the main slider bar if the 

shapefile includes Date and 

Time1 fields, otherwise “No 

data at No data” will appear 

next to Date:. If the shapefile includes a Time2 field and you have calculated travel times and distance (see 

below), the speed of travel and distance between points will be displayed above the date and time as 

locations are processed. The object ID (FID) of the starting location in relation to the total number of 

Figure 3. Display Travel dialog box. 
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records in the file is indicated (Fix) below the date and time, and is incremented as locations are processed. 

You can change the starting location within the range of selected points by dragging the main slider bar to 

the right. This will automatically update the values associated with the starting location. 

By default, an animal’s travel path is displayed automatically when the Display Travel button is 

clicked. If you prefer, the travel path can be displayed manually by checking the box next to “One Step at a 

Time” then clicking the Step Forward or Step Back buttons. It is assumed that the records selected from the 

file are in the sequence they are to be processed. If a fix is encountered during processing that has an object 

ID (FID) that is out of sequence (i.e. less than the previous value or greater than the previous value + 1), 

you will be notified that the track segment is out of sequence and asked if you want to draw the track 

segment anyway (click Yes) or skip it (click No). The travel path is displayed as a line with an arrowhead 

indicating the direction of travel between consecutive points that have been selected. The speed at which 

the path is drawn can be decreased by entering a value in the box or dragging the slider bar to the right in 

the Display Speed section of the dialog box (Figure 3). The Display Speed can be increased by dragging the 

slider bar to the left or by entering a smaller proportion in the box (e.g. 0.001). The display can be stopped 

and settings adjusted at any time by clicking the Stop button. To retain all lines connecting the selected 

points in the display, check the box next to “Keep Travel Path”, otherwise the line connecting two points 

will be deleted as the next line is drawn. The travel path can be saved as a shapefile by clicking the Save 

Travel button. To clear the travel path from the display, click on Delete Travel Path before closing the 

“Display Travel” dialog. Note that if you want to clear the travel path later, after closing the “Display 

Travel” dialog, you will have to reopen it and click on Delete Travel Path. 

Analyzing Fix Data 
Generating interfix distances and elapsed times or home range polygons from animal locations is a 

simple procedure. All you need to do is click the shapefile (point layer) in the Source or Display Table of 

Contents that you would like to analyze and make it visible by checking the box next to it, then choose the 

analysis you would like to use from the HRT Tools dropdown menu ( ). When using the “MCP 

Analysis” option, you will also need to select the points to include in the analysis; you can analyze all the 

points in the active shapefile by right clicking on the file name then choosing “Select All” from the 

Selection fly-out menu, you can use the Select Feature tool ( ) on the Tools Toolbar to drag a box around 

a subset of the points in the Data View window or use the “Select By Attributes…” or “Select By 

Location…” options on the Selection menu to select a subset of points, as outlined above. 

Calculating Interfix Times and Distances 

Although the “Display Travel” option allows you to step through selected points and visualize 

movement patterns, you may want to calculate and save interfix distances and elapsed times, as well as 

cumulative values for these variables. With these data, speed of movement can be determined and 

displayed along with the movement path when the “Display Travel” option is selected (see above). You 
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could also calculate average distance moved between fixes, average elapsed time between fixes, total 

distance moved in a given period, and so on. 

Select the shapefile that you would like to use and make it active by clicking on its name in the 

Source or Display Table of Contents. The HRT uses a “Time2” field to “Calculate Travel Times and 

Distances” between successive fixes so locations in your file must be associated with a linear “time” scale 

that provides a unique value for each point (see Text Files and dBASE Files above) and these values must 

be in a numeric field called “Time2”, otherwise this HRT option will not work. Now select “Calculate 

Travel Times and Distances” from the HRT Tools dropdown menu ( ). This will add 6 new 

columns to the Attribute Table of the shapefile (Figure 4), including elapsed time between consecutive 

fixes, cumulative time over which the points were 

recorded, distances between consecutive fixes, 

cumulative distances and speed of movement 

between locations in both m/sec and mph. Note that 

these fields will be added to the shapefile 

automatically without the need to save them as 

edits. You can now generate some simple summary 

statistics by right clicking on the file name, 

choosing “Open Attribute Table”, right clicking on 

the column you would like to analyze and selecting 

“Statistics…”. 

If you want to calculate interfix times, 

distances and speed of movement on a subset of the data or between non-consecutive fixes, you will have 

to create a new shapefile. Use the Select Feature tool ( ) on the Tools Toolbar to drag a box around a 

subset of the points in the Data View window or use one of the options on the Selection menu to select the 

points you want to include. You could also select points manually by opening the Attribute Table and 

choosing the points to be used with the Select Elements tool ( ); a range of points can be selected by 

holding the Shift key down while selecting the first and last records to be included or individual points can 

be selected by holding down the Ctrl key while selecting each point. After selecting all the points you want 

to include, right click on the file name in the Display Table of Contents window and select “Data” then 

“Export Data”. In the Export Data dialog, verify that “Export: Selected features” appears in the box, then 

select “Use the same Coordinate System as: the data frame”, specify the path and file name for the “Output 

shapefile or feature class:”, then click OK. Click Yes to add the exported data to the map as a layer. You 

can now “Calculate Travel Times and Distances” for the subset of data as above. 

 

 

Figure 4. Time, Distance and Speed of 
Movement fields added to the Attribute 
Table when the “Calculate Travel Times 
and Distances” option is selected. 
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Generating Minimum Convex Polygons 

The “MCP Analysis” option will make a minimum convex polygon (MCP) using the outer points 

in a group of selected fixes. Before proceeding with an MCP analysis, 

you should remove any duplicate locations (see Removing Duplicates 

section above) by choosing “Remove X/Y Duplicates” on the HRT 

Tools dropdown menu ( ). This is necessary because 

calculation of MCPs involves determination of distances between 

points and if the difference in x or y co-ordinates is zero it can 

result in a “division by zero” error that will cause ArcGIS to 

shut down. Removal of duplicate locations will have no effect 

on the construction of MCPs. 

To construct an MCP from all the points in a shapefile 

(point layer), following removal of duplicate locations, right 

click on the file name then choose “Select All” from the 

Selection fly-out menu. To produce an MCP on a subset of 

points in the Data View, use the Select Feature tool ( ) to 

drag a box around the fixes you want to include or use one of 

the options on the Selection menu. You can now apply one of 

the methods available in the HRT (Figure 5) to automatically 

select the outer points to be used to generate an MCP; 

Area Added 

This method drops points based on the amount of area they add to the home range polygon (White 

and Garrott 1990). To begin, a 100% MCP is calculated. The points that form the polygon are then deleted 

one at a time. After a point is removed a new MCP is constructed and its area is calculated. The difference 

in area between the new MCP and the 100% MCP is determined. The point is then restored and the next 

point is deleted. After all boundary points are tested, the polygon that had the greatest difference in area 

from the 100% MCP is identified and the associated point is dropped. The polygon constructed without this 

point becomes the new polygon against which to test the remaining points. This process continues until the 

requested percentage of points remains selected. This procedure can be excruciatingly slow, especially with 

many points. 

Fixed Mean 

This method calculates the arithmetic mean of all x (longitude) and y (latitude) co-ordinates, then 

selects the requested percentage of points closest to that arithmetic mean point. 

Remove duplicate locations 
before an MCP analysis. 
Remember to make a backup 
copy of your original 
shapefile(s) before you 
remove duplicates. 

Figure 5. MCP Dialog Box. 
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Fixed Median 

This method calculates the median of all x (longitude) and y (latitude) co-ordinates, then selects 

the requested percentage of points closest to that median point. 

Floating Mean 

This method calculates the arithmetic mean of all points, then drops the farthest single point. The 

mean is recalculated from the subset of points and another point is dropped. This continues until the 

requested percentage of points remains selected. 

Floating Median 

This method calculates the median of all points, then drops the farthest single point. The median is 

recalculated from the subset of points and another point is dropped. This continues until the requested 

percentage of points remains selected. 

User Centre 

This method selects the requested percentage of points closest to x (longitude) and y (latitude) co-

ordinates specified by the user. 

 

The default method for calculating MCPs in the HRT is “Fixed Mean” using 95% of the fixes 

(Figure 5). To generate a 100% MCP using all the fixes in a selected shapefile (i.e., connect the outermost 

points without removing any fixes from the calculation), select “MCP Analysis” on the HRT Tools 

dropdown menu ( ) then uncheck the box next to “Select Percentage of Points” or type 100 into 

the box next to “Percentage(s)” in the MCP dialog (Figure 5). If you want to remove a proportion of the 

outermost locations (e.g., because these might be considered “Occasional sallies outside the area, perhaps 

exploratory in nature” sensu Burt 1943: 351), you can automatically select a percentage of the locations to 

be kept using any of the available methods by checking the box next to “Select Percentage of Points”, 

entering the percentage of locations to be retained in the box next to “Percentage(s)” and choosing the 

“Selection Style”. If you select the “User Centre” method (slide bar down in the “Selection Style” box; 

Figure 5), you must also enter the x (longitude) and y (latitude) co-ordinates (in UTM units) of the specific 

location. 

Note that you can enter multiple percentages in the “Percentage(s)” box by separating each value 

with a comma; you will be asked for a file name to save each %MCP polygon before it is calculated. MCP 

polygons are automatically added to the Data View after they are calculated. To determine the area (square 

meters) enclosed by an MCP, open its corresponding Attribute Table. 
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Generating Kernel Polygons 

The “Kernel Density Estimation” option produces a set of polygons based on isopleths derived 

from the calculation of the standard bivariate normal (i.e., Gaussian) kernel probability density estimator 

(i.e., utilization distribution or KDE). Isopleths are calculated from the summed kernel volumes under 

different portions of the utilization distribution. A chosen smoothing parameter is calculated automatically, 

or you can enter a value manually, and the option provides both fixed and adaptive methods of smoothing 

the kernel probability density estimator. 

To start a kernel analysis, click the shapefile (point 

layer) in the Source or Display Table of Contents containing 

the fixes for which you would like to generate polygons and 

make the points visible by checking the box next to it. Only 

one shapefile at a time can be processed but the file may 

contain locations for multiple animals (see below). To 

produce polygons from a subset of the points in the Data 

View, use the Select Feature tool ( ) to drag a box around 

the fixes you want to include or use one of the options on 

the Selection menu. Choose “Kernel Density Estimation” 

from the HRT Tools dropdown menu ( ). The 

Kernel Density Estimation dialog box will open with 4 

visible tabs (Figure 6): Input Data, Kernel Settings, 

Bandwidth, and Output Options. These tabs allow you to 

specify input and output file names as well as the settings to 

be used for a kernel analysis. You can save the kernel 

analysis settings for use with other files, or retrieve previously saved settings using the Save Settings and 

Load Settings buttons at the bottom of the dialog box. 

Input Data Tab 

A point layer for analysis must first be entered in the box next to “Point layer” or selected from the 

drop-down list (Figure 7). You have the choice of using all the points in the file, or only those pre-selected 

using one of the techniques described above. To use a pre-selected subset of points, check the box next to 

“Use selected features only”, otherwise all locations in the specified shapefile will be used. 

Figure 6. Kernel Density Estimation 
dialog box with Input Data, 
Kernel Settings, Bandwidth, 
and Output Options tabs. 
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The “Kernel Density Estimation” option in the 

HRT can process multiple animals in batch mode. Simply 

enter a “Unique animal ID field for batch processing” in the 

box or select the corresponding field name from the drop-

down list (Figure 7). Note that you must still specify an 

animal ID field even if all the points in the file to be 

included in the analysis are from the same animal. If you 

need to create an animal ID field, open the attribute table 

associated with the shapefile and click the Options button, 

then select “Add Field” to create a Text field and populate it 

with the same string for each animal. It is critically 

important that the animal ID field is defined as Text (i.e., 

alphanumeric) and that the same ID is used for every record 

corresponding to each animal. We made the animal ID field 

alphanumeric to accommodate the hexadecimal codes used 

by some GPS collar 

manufacturers to 

identify individual units and other users who do not use numeric values 

(e.g. some researchers like to give their animals names): note that 

numeric values (e.g., collar frequencies, ear tags) can be converted to 

text but not the reverse. 

Independence of successive animal locations is a basic assumption of many statistical methods of 

home range analysis. Temporal autocorrelation (sometimes called serial correlation) of fix data tends to 

underestimate true home range size in these models (Swihart and Slade 1985a). Schoener (1981) proposed 

a statistic for detecting departures from independence of observations based on the ratio of the mean 

squared distance between successive observations and the mean squared distance from the centre of 

activity. Significant deviations of Schoener’s index from an expected value of 2.0 (i.e., <1.6 or >2.4) 

indicate a strong correlation between distance and time (i.e., the animal did not have time to move very far 

before it was located again or it is repeating a previous pattern of movements). 

Swihart and Slade (1985a) derived the sampling distribution of Schoener’s index and provided a 

test of independence that can be used to determine the time to independence between observations (i.e., the 

minimum time interval between successive observations that allows them to be considered independent). 

They later provided their own bivariate measure of autocorrelation, which included terms for both serial 

correlation and cross correlations (Swihart and Slade 1985b). High values of the Swihart and Slade index 

(i.e., >0.6) indicate significant autocorrelation (Ackerman et al. 1990). 

By pressing the Calculate button on the Input Data tab, Schoener’s (1981) index and the Swihart 

and Slade (1985b) index will be calculated from the locations corresponding to each animal ID (Figure 7). 

The Unique animal ID field 
must be defined as Text 
(i.e., alphanumeric) and the 
same ID must be used for 
every record corresponding 
to each animal. 

Figure 7. Kernel Density Estimation 
dialog box with Input Data tab 
selected and showing 
Independence of observations 
calculations. 
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If either or both of these indices suggest your data are autocorrelated you might consider randomly deleting 

locations until these indices are no longer significant (Ackerman et al. 1990) or, more objectively, use the 

method developed by Swihart and Slade (1985a) to determine the time to independence and remove the 

intervening locations. For later reference, these independence statistics may be saved as a simple text file 

(csv format) by pressing the Save As… button. 

Kernel Settings Tab 

Standard deviations of the x and y values corresponding to each animal ID, including the sample 

size used, are calculated and displayed on the Kernel Settings tab (Figure 8). Since the smoothing 

parameter (h) is an expression of the variances or standard deviations of the x and y co-ordinates around a 

given point, and applying a single smoothing parameter assumes each data point is scaled equally in all 

directions (Silverman 1986), it may be necessary to rescale the data before any kernel method is applied 

(Worton 1989). To simplify comparisons, the Ratio of the standard deviations, StdDev(x) and StdDev(y), is 

also shown for each case; significant deviations of this ratio from a value of 1.0 (i.e., <0.5 or >1.5) indicate 

data should be rescaled before any kernel method is applied. 

To rescale the data, check the box next to “Rescale 

to unit variance”, otherwise the original observations will be 

used to calculate the smoothing parameter by one of the 

automated methods on the Bandwidth tab (see below). 

Rescaling the data to have unit variance changes the co-

ordinates of the fixes by dividing each value of x and y by 

its respective standard deviation (Seaman and Powell 1996). 

The HRT allows the user to select either fixed 

kernel or adaptive kernel methods of estimating a utilization 

distribution. The fixed kernel approach assumes the width 

of the standard bivariate normal kernel placed at each 

observation is the same throughout the plane of the 

utilization distribution. This can be problematic if there are 

outlying regions of low density because it is difficult to 

select a smoothing parameter that will accommodate these 

outer areas without “oversmoothing” the core of the 

distribution. The adaptive kernel method, on the other hand, 

allows the width of the kernel to vary such that regions with 

low densities of observations are smoothed more than areas 

of high concentration. This can produce “oversmoothing” of the outlying regions of the distribution. 

Whereas Worton (1989) found the adaptive kernel approach provided better estimates of home 

range size derived from a utilization distribution than the fixed kernel method, Seaman and Powell (1996) 

found the opposite. One explanation is that the widening of kernels in outlying regions by the adaptive 

Figure 8. Kernel Density Estimation 
dialog box with Kernel Settings 
tab selected and showing sample 
size, standard deviations of the x 
and y values corresponding to 
each animal ID and Kernel 
parameter options. 
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approach may produce unacceptable expansion of the utilization distribution (Kenward and Hodder 1996). 

It is more likely, however, that differences in performance of the two methods noted by these authors are 

simply a consequence of the different sets of observations used in each study. Therefore, we suggest the 

choice of which smoothing approach to use depends on the original observations and is left up to the user to 

determine through exploration of their data. 

The HRT uses a bivariate normal or Gaussian kernel, referring to the shape of the probability 

distribution placed over each observation point in bivariate space. No other choices are available in the 

HRT at this time. Gaussian kernels are widely used in kernel analyses but others (e.g., Epanechnikov) 

might also be applied (Silverman 1986), so we have provided a window for choosing other kernel shapes in 

future releases of the software. 

Bandwidth Tab 

Choosing an appropriate smoothing parameter (i.e., “bandwidth”) is the most important step in 

deriving a kernel density estimator (Worton 1989) but there is no agreement on how to approach this 

problem (Silverman 1986, Wand and Jones 1995, Jones et al. 1996, Gitzen and Millspaugh 2003, Hemson 

et al. 2005, Gitzen et al. 2006, Horne and Garton 2006, Fieberg 2007a,b, Downs and Horner 2008, Kie et 

al. 2010). The smoothing parameter (h) determines the spread of the kernel that is centred over each 

observation. If the value of h is small, individual kernels will be narrow and the kernel density estimate 

(KDE) at a given point will be based on only a few observations. This may not allow for variation among 

samples (e.g., frequency of collection of location data, length of collection period, seasonal effects, etc.) 

and may produce an extremely variable, “undersmoothed” utilization distribution. On the other hand, if the 

value of h is large, individual kernels will be wide and the resulting “oversmoothed” utilization distribution 

may obscure the fine detail required to identify centres of activity. The HRT provides several automated 

and subjective methods of finding a variety of values for h in a given situation. 

An automated method of choosing a starting value for h is to use the optimum value with 

reference to a known standard distribution such as the bivariate normal distribution (Silverman 1986; 

Worton 1989, 1995). Calculation of this reference bandwidth (href) assumes your data are normally 

distributed in bivariate space (Silverman 1986; Worton 1989, 1995). Since the HRT uses a standard 

bivariate normal probability density function to estimate the utilization distribution, href is calculated 

(equation [1]) as the square root of the mean variance in x (varx) and y (vary) co-ordinates divided by the 

sixth root of the number of points (Worton 1995); 
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The value of href for the locations corresponding to each 

animal ID in the shapefile selected in the Source or Display 

Table of Contents, or a subset of points selected in the Data 

View, is shown on the Bandwidth tab (Figure 9). Units for 

href will be the same as the input units. Typically href units 

are meters. However, if you rescaled to unit variance on the 

Kernel Settings tab, units for href will not be readily 

interpretable (the units will be “standard deviations”). If 

you wish to record href with meaningful units, simply return 

to the Kernel Settings tab, unclick “Rescale to unit 

variance”, then go back to the Bandwidth tab and record 

href. If you had decided to rescale your data, remember to 

return to the Kernel Settings tab and re-click “Rescale to 

unit variance” prior to running the kernel analysis. 

The href method is effective if the underlying 

utilization distribution is unimodal (i.e., “single-peaked”) 

(Worton 1995) and is the default method of bandwidth 

selection in the HRT. This method may be sufficient to 

describe a concentrated group of points selected in the Data View, but will usually oversmooth the 

utilization distribution for an entire shapefile because animals typically have multiple centres of activity 

within their home range. Consequently, you will probably want to try one or more of the other Bandwidth 

Selection methods available on the Bandwidth tab (Figure 9). 

Least-squares cross-validation (LSCV) is the most common method for automatically calculating 

a smoothing parameter. The LSCV method attempts to find a value of h that minimizes the mean integrated 

square error (MISE) by minimizing a score function CV(h) for the estimated error between the true density 

function and the kernel density estimate (Worton 1995); 
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The minimum value of CV(h) is found using a linear search algorithm that tests 200 values of h between 

0.05href and 2href . The resulting smoothing parameter that minimizes the score function is called hlscv. 

In situations where the utilization distribution is not unimodal, the LSCV method has been shown 

to overcome the problem of oversmoothing associated with the use of href (Worton 1989). On the other 

Figure 9. Kernel Density Estimation 
dialog box with Bandwidth tab 
selected, showing the value of 
href for the points and the various 
methods available in the HRT for 
bandwidth selection. 
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hand, LSCV may drastically undersmooth the utilization distribution if there are numerous small clusters of 

points (i.e., centres of activity) in the data (Park and Marron 1990). Indeed, the LSCV method has a 

propensity to show structure in the data when none exists (Sain et al. 1994). Further, the LSCV method is 

not always successful in finding a smoothing parameter that will minimize the MISE. In these cases, the 

HRT will provide a warning message and will revert to using href (i.e., “Warning: the LSCV function failed 

to minimize between 0.05*HREF and 2.00*HREF.  The bandwidth defaulted to HREF.”) 

A technique that may strike a balance between the tendency of href to oversmooth and hlscv to 

undersmooth utilization distributions is biased cross-validation (BCV). In contrast with the LSCV method, 

BCV attempts to find a value of h that minimizes an estimate of the asymptotic mean integrated square 

error (AMISE). AMISE is a large sample (e.g., n>50) approximation of the MISE (Wand and Jones 1995). 

Thus, it also provides an estimate of the difference between the true density function and the kernel density 

estimate. However, it is computationally faster and easier to calculate than MISE (Sain et al. 1994, Wand 

and Jones 1995, Jones et al. 1996). In the HRT, the function to be minimized is (Sain et al. 1994); 
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where the distance between pairs of points (Dij) is again calculated as in equation [3] above. Similar to the 

LSCV method, 200 values of h between 0.05href and 2href are tested using a linear search algorithm to find 

the minimum value of BCV2(h). The resulting smoothing parameter is called hbcv2. 

Simulation studies show the BCV method performs quite well in comparisons with the LSCV and 

reference methods (Sain et al. 1994). However, the BCV method has not been investigated in the context of 

home range estimation. Due to similarities with the linear search algorithm used by the LSCV approach, 

the BCV method may also fail to find a smoothing parameter that will minimize the AMISE. In these cases, 

the HRT will again provide a warning message and revert to using href. 

Both the LSCV and BCV methods of selecting a smoothing parameter can run into problems if 

there are a large number of duplicate locations recorded for an animal (e.g., at a nest or den site) because 

the distance between pairs of points (Dij) will be zero for all of these locations. The distance between points 

might also become zero due to round off or “discretization” of x and y co-ordinate data (Silverman 1986). 

The result is that the exponents in the score functions (equations [2] and [4]) will always evaluate to 1, 

regardless of the value of h. Consequently, when the distance between points is zero, all values of h will 

produce the same value for the score functions and no single value of h will be found that minimizes the 

MISE or AMISE functions. As noted above, the HRT will provide a warning message and will revert to 

using href when no single value of h can be found that minimizes the MISE or AMISE functions. 

Even if the LSCV or BCV method is successful in finding a smoothing parameter, duplicate 

locations, or numerous points that are very close together, can have a disproportionately large influence 

(i.e., bias) on the overall estimate of the MISE or AMISE functions because of the summation component 

in the score functions (equations [2] and [4]). This may produce very small values of h that minimize the 
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MISE or AMISE functions and drastically undersmooth the utilization distribution. Indeed, duplicate 

locations or numerous points that are very close together could end up producing the degenerate value h = 0 

(Silverman 1986) as the solution. If the HRT encounters duplicate points, or points that are very close 

together, a warning message will appear (i.e., “Warning: Overlapping points were detected for the 

following animals:    This may prevent reasonable estimation of the bandwidth”) and you will have the 

option to proceed or not. If you choose to proceed you may encounter another warning message if the 

process fails to find a value of h that will minimize the MISE or AMISE functions. If this happens, the 

HRT will revert to using href as described above. One possible way out of this situation is to shift duplicate 

points or points that are very close together some randomly selected distance from their original values, but 

we are not aware of any studies that have determined the implications of doing this. Another choice might 

be to use the “Remove X/Y Duplicates” option on the HRT Tools dropdown menu ( ) to get rid 

of identical points. However, this is not a good solution because the utilization distribution is created from 

kernel density estimates and removing any points will change these densities and affect the shape and 

extent of the utilization distribution. As a last resort, you may have to use a different method of choosing an 

appropriate smoothing parameter. 

In part, your selection of method for choosing a smoothing parameter will depend on your purpose 

in creating a utilization distribution. If you are planning to use the utilization distribution to delineate and 

determine the area of a “home range”, then you will probably want to construct isopleths from a kernel 

analysis and determine the area enclosed by a continuous outer isopleth (e.g., 90, 95, or 99%). However, 

the reference and cross-validation methods do not always produce utilization distributions with continuous 

outer isopleths from which to estimate the area of a home range. Rather than using the reference bandwidth 

(href) or that determined by LSCV (hlscv) or BCV (hbcv2), we suggest it might be better to incrementally 

decrease (or increase) the proportion of href associated with individual data sets until the outermost isopleth 

breaks down (or becomes continuous) to determine a home range estimator. For example, decrease the 

value of href to 0.95href, then 0.9href, 0.85href, and so on until the outermost isopleth breaks the points up into 

disjunct “clumps”. Once that happens, backtrack to the previous proportion of href that did not cause a 

break-up of the home range isopleth and use that as your smoothing parameter to define the home range 

boundary and obtain an area estimate. This process can also be implemented from the “bottom up”; i.e., 

start with a small proportion of href, then increase it by some amount (e.g., 0.05) until the outermost isopleth 

becomes continuous. Although not fully automated, the process is repeatable and therefore valid in a 

scientific sense. It does not require the removal of duplicate locations. Further, the HRT is set up to 

facilitate the process; on the Bandwidth tab, check the radio button next to “Proportion(s) of reference 

bandwidth”, type in several values for the proportions you would like to test (or you can use the default 

values already in the box) and the program will produce multiple outputs for each animal using the 

different proportions of href. Be warned, however, that the program could take a while to run and will 

produce a lot of files, depending on the number of proportions you enter, the number of animals in the file 

and the numbers of locations per animal. If you run animals individually, keep in mind that you can use the 
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Save Settings and Load Settings buttons at the bottom of the dialog box, so you don't have to type 

everything in again for each animal. The method we have suggested is referred to as the “ad hoc” method 

by Berger and Gese (2007) and Jacques et al. (2009), and is further discussed by Kie et al. (2010). 

In the event that the automated methods do not provide a suitable value for the smoothing 

parameter, the HRT allows you to input a subjective choice by checking the radio button next to “User 

defined” and entering a value. This feature is particularly useful for data exploration and hypothesis 

generation. In addition to helping you choose the “best” smoothing parameter, these subjective choices may 

allow you to highlight various features of a home range dataset that may not be immediately obvious from 

a simple plot of animal locations or one of the automated methods. Note that the entered value must not be 

scaled (i.e., it is in the original units) and the same value will be used for all animals in the shapefile 

selected in the Source or Display Table of Contents. 

Output Options Tab 

The HRT provides output of kernel analyses as both rasters and polygon features (Figure 10). 

Begin by specifying a location for the output of the raster layers and polygon features in the “Output 

folder” box or you can Browse to a preferred location by clicking the folder ( ) icon. We strongly advise 

you to create a new folder each time you run a kernel analysis and to use highly descriptive file names 

because it can quickly become overwhelming and confusing as you try different approaches to the analyses 

of your data. Next, you will need to provide a “Raster name 

prefix” or you can use the default prefix “kde” already in 

the box. You should keep this prefix as short as possible 

because the Unique animal ID(s) you specified on the Input 

Data tab will be added following this prefix and ArcGIS 

restricts the names of the raster layers that will be produced 

to a maximum of 14 characters. 

The kernel methods implemented in the HRT 

calculate probability density estimates at the centre of each 

cell in a raster (i.e., grid) of cells. The process is 

theoretically independent of resolution. However, 

preliminary tests indicate that very coarse resolutions may 

produce home range estimates that are very different than 

area calculations based on higher resolutions. By default, 

the HRT uses a raster cell size of 100 x 100 coordinate 

system units (meters, when using a UTM projection). Finer 

resolutions can be specified in the “Raster cell size” box (in 

the original units) but the value must not be larger than the 

Figure 10. Kernel Density Estimation 
dialog box with Output Options 
tab selected, showing the various 
options for raster and polygon 
output of the kernel analysis 
results. 
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bandwidth. Increasing the resolution of the raster may require an increase in the scaling factor (see below) 

and could dramatically increase computing time. 

The “Scaling factor (multiplier)” is needed for the raster output. To create the raster, the volume of 

the entire utilization distribution is scaled to a value of 1 and the proportion of the total volume associated 

with each cell is assigned. Depending on the extent of the utilization distribution and the distribution of 

points over the area, and especially if there are duplicate locations or numerous points that are very close 

together, some cells may have extremely small values. The default Grid structure in ArcGIS uses single 

precision (32 bits – for the sake of argument think of this as 8 significant digits), so to avoid major loss of 

information due to truncation of extremely small double precision numbers (64 bits – 16 significant digits) 

such as something like 0.00000000789321, we apply a scaling factor. The default multiplier in the HRT is 

1 x 106, so the volume of the function is thus no longer 1, it is 1 * scaling factor. So, for example, the 

previous value would be stored as 0.00789321. Since the scaling factor is applied across the entire 

utilization distribution, it has no effect on the isopleths. 

If you increase the resolution of the raster, you may also need to increase the value of the scaling 

factor because the number of cells in the raster may become too large or the proportion of the total volume 

associated with each cell may become too small. For example, if your study area were 500 x 500 km in size 

and you reduced the Raster cell size to 10 x 10 m, the raster will require 2,500,000,000 (2.5 billion) cells 

and likely produce the error message “Kernel calculator: 1000 Out of memory”. If evenly distributed, the 

volume of each cell in this raster would be 0.000004 using the default multiplier, but following application 

of the smoothing parameter it is quite likely that the volume of some cells would fall below 1 x 10-15. In 

general, you should use the default value of the scaling factor or increase the value but do not reduce it 

without careful consideration. 

Although not selected by default, you should check the radio button next to “Write verbose 

analysis log file”. This will create a text file called “HRT_KDE_ANALYSIS.txt” that contains diagnostics 

for each analysis including your input parameters and many intermediate values such as the bandwidth 

used, LSCV scores, and others. Having this information can greatly assist choosing values for subsequent 

analyses and for trouble-shooting any problems that may arise. 

The next section of the Output Options tab deals with the spatial extent of the output raster. 

Isopleths of the utilization distribution are created from the raster and outer isopleths (e.g., 95 or 99%) will 

typically extend beyond the boundaries of the area covered by the location data, so it is usually necessary to 

add a buffer. The HRT will estimate the extent of the required buffer and make a default suggestion. In 

most cases, the suggested value will be satisfactory but you can enter a new value (in the original units; i.e., 

meters) if you wish. You can also check the radio button next to “Minimize the extent of each UD” and no 

buffer will be added. Instead, the minimum and maximum x and y co-ordinates of the input point layer will 

be used to define the extent of the output raster. Combined with the Raster cell size and Scaling factor 

previously specified, minimizing the extent of the utilization distribution or reducing the size of the buffer 

can cause a warning message to appear (i.e., “Warning: It is possible that the extent of the raster was not 
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large enough to accommodate the utilization distribution. Data truncation may therefore have occurred, and 

this can profoundly disrupt the isopleth calculation. It is recommended you inspect the vector isopleth 

carefully to determine if it is valid.”). You will then need to increase the size of the buffer or adjust your 

settings for the Raster cell size and Scaling factor. 

A very useful option is the ability for the user to specify an existing raster layer as the extent of the 

raster calculated in the HRT by selecting “Every UD is calculated at the same extent as this raster layer”. 

For example, specifying a habitat raster layer derived from Landsat imagery will provide a grid cell 

structure of 30 x 30 m and the utilization distribution will be calculated for each of those cells. This can be 

extremely valuable in resource selection studies. Alternatively, prior to your analysis of multiple animals, if 

you create a single study-wide raster, the utilization distribution for each animal will be calculated based on 

that command raster, which will facilitate overlap comparisons. 

The final section of the Output Options tab deals with the output of polygon features. If you want 

the HRT to calculate isopleths, check the radio button next to “Isopleths (%)”. You can choose to output 

the default isopleths (i.e., 95, 99, 50%) or you can check the button and enter your own values separated by 

commas, for example to do both a total home range analysis and also obtain a series of core areas. Note that 

because the HRT uses a bivariate normal (Gaussian) kernel, the tails of the kernel probability density 

estimator (KDE) are infinitely long, so it is mathematically impossible to sum 100% of the volume under 

an entire utilization distribution. Consequently, you should not specify a value greater than 99.99%. Keep 

in mind that the outer isopleth of a utilization distribution does not have to be continuous to conform to 

Burt’s (1943) definition of a “home range”. If a kernel analysis produces a utilization distribution with 

several clusters that’s fine – it just means there is less chance of finding the animal in the spaces between 

clusters – it does not mean the area is never used. However, if it is your objective to delineate and 

determine the area of a “home range”, then you will probably want to construct isopleths from a kernel 

analysis and determine the area enclosed by a continuous outer isopleth (e.g., 90, 95, or 99%). Regardless, 

you must always recognize that the area of a “home range” determined by any method provides an index 

but not an absolute measure of space use of an animal through time. 

If you have chosen to calculate isopleths then you have three options for outputting the results by 

checking the radio button next to the corresponding polygon feature; choosing “Lines” provides the 

perimeter length (meters) of the specified isopleths, “Polygons” provides the perimeter and the area (square 

meters) enclosed by each of the specified isopleths, and “Donut polygons” determines the areas between 

isopleths if more than one has been specified. 
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Appendix: 3D View of Utilization Distributions 
 

Sometimes it may also be useful to explore a utilization distribution created from a kernel analysis 

in the HRT by rendering it in 3 dimensions. The following steps demonstrate how this can be done in 

ArcGIS using the raster output from the kernel analysis: 

 

1. Open ArcScene and add the raster output for the utilization distribution that you saved in the file/folder 

specified on the Output Options tab of the Kernel Density Estimation dialog using the Add Data ( ) 

button, or select “Add Data…” from the File menu. You can also add the animal locations used to 

generate the utilization distribution and/or the resulting isopleths from the kernel analysis (NOTE: if 

you want to superimpose these layers on the 3D view of a utilization distribution, you must add these 

layers before proceeding to the next steps – if you try to add these layers later, a quirk in ArcScene will 

prevent overlaying them). 

 

 
 

2. Right click on the raster file name in either the Source or Display Table of Contents window and select 

“Properties…” then the Base Heights tab in the Layer Properties dialog box that appears. Now click 

the radio button next to “Obtain heights for layer from surface” and check that the path leads to the 

same raster file as in the previous step. Click the Apply button then the OK button to close the dialog 

box. Follow the same procedure and make the same choices for any additional layers (e.g., animal 

locations, isopleths) that you may have added to the Data View. 
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3. Reopen the Layer Properties dialog box by right clicking on the raster file name in either the Source or 

Display Table of Contents window and select “Properties…”. Click the Symbology tab and select a 

color ramp that will apply different colors to the heights of the grid cells in the raster. Click the Apply 

button then the OK button to close the dialog box. 

 

 
 

If you have added any additional layers, you may want to change the shape, size and/or colors of points 

or lines in the Data View. You can do this by clicking on the colored symbol or line under the layer 

name in the Source or Display Table of Contents window, then choose your desired Options in the 

Symbol Selector dialog and click the OK button when done. 
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4. Click on the View menu in ArcScene, choose Scene Properties and select the General tab. Now specify 

the Vertical Exaggeration for the utilization distribution. The value you choose is completely arbitrary 

– the intent is to visualize the utilization distribution in a way that will allow you to compare areas of 

high (peaks) and low (valleys) use. Keep in mind that each cell in the raster represents a very small 

proportion of the utilization distribution so the value you enter will probably need to be very large 

(e.g., >10,000). You can also change the Background color of the Scene to gain better contrast with the 

color ramp you selected previously. 
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5. You are now ready to explore the utilization distribution in 3D. You can use the scroll button on your 

mouse to zoom in and out, or use some of the tools on the Tools toolbar to navigate the view. In 

addition to the Zoom and Field of View buttons on the Tools toolbar, the main tools are: 

 The Pan tool ( ) allows you to move the entire scene left, right, up or down. 

 The Navigate tool ( ) lets you rotate the entire scene in any direction by holding 

down the left mouse button while dragging the cursor. 

 The Fly tool ( ) allows you to navigate through a scene with the ability to move 

continually in a particular direction. Click the tool, move the cursor near the middle of 

the scene, then click the left mouse button to start. If you want to go faster, double 

click the left mouse button. If you want to go slower, double click the right mouse 

button. When you want to stop, click the Escape (Esc) key on your keyboard. 

 Clicking Full Extent ( ) will get you back to viewing the entire scene in the View 

window. 

 

Effect of choosing different values for the Vertical Exaggeration of a utilization distribution; the 
view on the left used a value of 10,000 and the view on the right used a value of 20,000. 


